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and versatile tools because they eliminate the need tg

ther worksheets or workbooks.
the lookup value vertically down the first column of the

« Lookup functions are powerful Opy

or recreate data that exists in 0
e The VLOOKUP function will look for
table array range.
e The lookup value must exist
VLOOKUP function or the func
e The HLOOKUP function will look
find the lookup value. _
The HLOOKUP function will produce the #N/A output if the lookup value is not in the firgy
row of the table array range. _
e If the “range_lookup” argument is defined with the word “TRUE", the data in the table array

range for the VLOOKUP function must be sorted in ascending ordel_' (smallest to largest)
based on the values in the first column, and for the HLOOKUP function the data must be

sorted in ascending order from left to right based on the values in the first row.

e If you are copying and pasting a VLOOKUP or HLOOKUP function to other cell locations on
a worksheet, there should be an absolute reference placed on the table array range.

e Icon Sets are a conditional formatting feature that can be used to apply data visualization
techniques to a dataset.

* The “value” argument of the ISBLANK function should be defined with only one cell location
and not a cell range.

in the first column of the table array range when using the
tion will produce the #N/A error.
horizontally across the first row of the table array range 1

6.3 Chapter Assignments and Test

Data Analytics (Skills Review)

Retail Inventory Exceptions (Comprehensive Review)
Starter File Name: Chapter 6 DA Exercise 1

Digital Downloads

Chapter 6 DA Exercise 1.xIsx
https://catalog.flatworldknowledge.com/a/34751/Chapter_6_DA_Exercise_1-42fe.xlsx

Difficulty: Level 2

Exception analytics plays a significant role in the evaluation of inventory for companies in the retall
industry. Large retail corporations may service thousands of customers in hundreds of storés
every day. Suppyling these stores with the appropriate amount of inventory is a considerable
challenge. Allowing inventory levels to get too low can jeopardize sales as customers may ot
find the items they wish to buy. Exception analytics are often used to evaluate sales and inventory
levels by store to prioritize inventory shipments. The purpose of this exercise is to wtilize the EX°®
skills covered in this chapter to create various exception alerts that will help a retailer organize
and prioritize inventory store shipments.

Begin the exercise by opening the file named Chapter 6 DA Exercise 1. Questions that are P'¢”
ceded with the letters KO indicate you must only use your keyboard and not your mousé @
execute the required skill.



chapter 6 Exception Analytics

© ©® N

10.
11.

12.

13.

14.
15.
16.

17.
18.

. Enter a SUM function in cell G2

; on th
should sum the values in the Invento © Sales and Inventory worksheet. The SUM function
include row 40. y Value column. Add cell capacity to the function to

Copy cell G2 and paste it into cells H2 and 12
Enter an HLOOKUP function i '
ahow the region namenffg;n tl: csll 54 on the Sales and Inventory worksheet that will
should be defined with cell Ag € Region Plan worksheet. The “lookup_value” argument
argument should be the range gr; ‘the Sales and Inventory worksheet. The “table_array”

9 ‘ES on the Region Plan workshest. Place an absolute

Copy cell B4 and paste it into the range B5:827

Enter a VLOOK ion i

L Yo eacll’J\PsIg?eCt;?n in cell E4 on the Sales and Inventory worksheet that will show

i bo e it Co;‘ln Cthe Store Details worksheet. The “lookup_value” argument

Srgument should be the ell C4 on the Sales and Inventory worksheet. The “table_array”

e i) fl_ing? A3':F26 on the Store Details worksheet. Place an absolute
i b ge. The “col_index_num" argument should be the number 5 and the
range_lookup™ argument should be the word “FALSE".

Copy cell E4 and paste it into the range E5:E27.

Enter a formula in cell J4 that divides cell 14 by I2. Place an absolute reference on cell I2.
Copy cell J4 and paste it into the range J5:J27.

Enter an IF func@non in cell M4 to determine if a store is a high growth exception. If the
value in "cell K4 IS greater than 5%, then the output of the function should be the word
“Growth". Otherwise, there should be no output for the function. The “logical_test” argu-
ment should be K4>5%. The “value_if_true” argument should be the word “Growth” and
must be enclosed in quotations. The “walue_if_false” argument should be two quotations
to leave the cell blank.

Copy cell M4 and paste it into the range M5:M27.

Begin an IF function in cell N4 on the Sales and Inventory worksheet. The purpose of this
function is to determine if it is OK to deliver inventory to a store or if the delivery should be
postponed. It can be a problem for smaller stores if too much inventory is delivered. For
this company, a small storé is 10,000 square feet.

Define the “logical_test’ argument of the IF function by using the AND function. The first

logical test of the AND function should determine if cell F4 is equal to 10000. The second
logical test of the AND function should determine if cell L4 is greater than 8. Cell L4 con-

i ich i [ how fast the store is selling
tains the weeks of supply which is a calculation 'that shows
its current inventory. A high weeks of supply indicates that a store may have too much

inventory relative to sales. - -
1 i “« 0 u- s n o
“yalue_if_true” argument of the IF function with the wor .
Irjezle?testgf tthe AND function, if a store is 10,000 square feet “and tpe weeks of supply is
greater than 8, the output of the function should be the word “Hold".
Define the syalue_if_false” argument with the word “OK".

Copy cell N4 and paste it into the rangé N5:N27. .

Ent?; a nested IF function in cell O4 to identify the lnve'nt?;y Svt\?;uisf(gf eSaLj:h Istoor;_urTnhne

inventory status will be determined pased on the \_/alu_e in | Li w es ol 4p|?t¥1 &l -
i f the first IF function should determiné if cel“ is e . e fg

tost |'Oglca| e tput of the function should be the word “Low". Start a secon IF func-

:i?)sr: :f\ tt:wu: '“:QEJ: uifpfalse" argument of the first |F function. The logical test of the second

n cell L4 is greater than 8. If this logical test is
; funcr:]tion tshotulcfl the hould be the word “High". If this logical test is not true, the
true, the output 0

function should output the word uNormal". The word “Normal” should be used to define
unction s

function.
the “value_if_false” argum ond IF

ent of the SeC
iti he rangé 05:027. .
Copy cell 04 and pa?te tinto ines If a store should be identified as a priority
Enter an IF function [ cell. fine the "Iogical_test" argqment of the IF function. The
delivery. Use the hould determine if cell K4 is greater than 8%. The sec-
first logical test ©

he O hould determine if cell L4 is less than 4. If the output
ond logical test of the
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nction should be the word “Priority”, ¢,
ould leave the cell blank, Therefor 8
ith two guotations. g,

of the IF fu
the IF function sh

of the OR function is true, the output
f the IF function W

output of the OR function Is not true,
define the “value_if_false" argument O

i p5:P27.
19. Copy cell P4 and paste it Into the rangeé
20 Ent?r/ an IF function in cell A2 that will alert the user if data has been added to the Work.

ity i M functions in the range G2:12. Usg
cell capacity in the Su _ he
fé‘éﬁf«&hé‘ffé‘;?ff isnttr;we(a “logical_test” argument of the IF fuﬁm ,sze 'SE:kANK function
should determine if cell A41 is biank. If the output of the LSEiSBLA I\IJ?< ;‘ljr?‘.moen' the outpyt
of the IF function should be & blank cell. If the output of the nis false, the

i : rt totals are missing datal.
output of the function should be: Repo '9 G2 '
21. Apply the traffic light icon set from the conditional formatting list of options to the Weeks of

i L4:L40 to add cell capacity to this conditional formgt,
Supply column, Highlight oo o Icon Sets sub menu, make the following

After selecting the More Rules option from th . . ‘
rule change tc? the green and yellow circles in the New Formgttmg Rule dialog box: Set the
type for each circle to Number. Set the value for the green c1rc|§: to 8 anq set the value for

that is less than 4 will be assigned a red circle,

the yellow circle to 4. Any weeks of supply ‘
These are stores that might be in danger of running out of inventory.

22. Save and close your workbook.

Payroll Taxes for a Medical Group

Starter File Name: Chapter 6 DA Exercise 2

Digital Downloads

Chapter 6 DA Exercise 2.xlsx
https://catalog.flatworldknowledge.com/a/3475 1/Chapter_6_DA_Exercise_2-7229.xIsx

Difficulty: Level 2

The Excel skills demonstrated in this chapter for the purpose of conducting exception analytics
can also be used to calculate payroll taxes and benefits for the employees of a medical group.
Medical groups are common in the health care industry and can range in a variety of sizes. The
defining trait of a medical group is that more than one doctor is on the staff for a particular prac-
tice, which creates more flexible hours for patients and physicians. In addition, a medical group
can provide a variety of medical services in one location. The purpose of this exercise is to use
the Excel and exception analytics skills covered in this chapter to prepare a payroll tax and ben-

efits worksheet.

Begin thg exercise by openi.ng ‘the file named Chapter 6 DA Exercise 2. Questions that are pre-
ceded with the letters KO indicate you must only use your keyboard and not your mouse to
execute the required skill.

1. Set the Freeze Panes command on the Payroll Details work
sheet so that rows 1 and 2
and columns A and B are locked in place while you scroll through the worksheet.

2. Enter an [F function in cell G3 on the Payroll Details worksheet to calculate the Social
Security tax. Spolal Security funds are used by the government to provide income for peo-
ple who are retired, a beneficiary of a retires, or disabled, An employer must withhold 6.2%
of an employee’s weekly‘pay for Social Security. However, an emplovee’s salary is taxed
up to $100,000. The'logucal test of the IF function should' assessplf ¥he value r?wl the Pay
Year to Date co!umn is greater than or equal to 100000. If the logical test is true, the out-
put of the function should be 0. Otherwise, the function shouldgmulti ly the value in the
Gross Pay This Week by 6.2%. Copy and paste the function into the r:née 34'622.

3. Enter a formula in cell H3 on the Payroll Details
; worksheet that he Medicaré
Tax. Medicare funds are used by the government to provide me;gﬁuf:i:aenscltal pmort 0

senior citizens. Your formula should multiply t
and paste this formula into the range H4:HFA)’2)2I. ne Gross oy Thia Wik by 11408 -
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are no user inputs required, this worksheet can pe pro-

; i ere .
the Transactions worksheet. Since th 4 on the report are not inadvertently changed or deleteq

tected so the formulas and functions usec p
The following reviews how this is accomplished.

1. Open the Summary worksheet. .

2. Click the Protect Sheet button in the Review tab of the Rlbbon.'

3. Click the OK button on the Protect Sheet dialt_)g box. Thi§ will protegt tf?e worksheet from
being changed. However, the worksheet protection can ?asxly be turned off. If.a stronger data
internal control is needed, a password could be entered in the Protect Sheet dialog box which

would be required to turn off the worksheet protection.

Keyboard Only

Current Date
e Hold the CTRL key and tap the semicolon ; key.
Current Time
e Hold the CTRL key and the SHIFT key and tap the colon : key.
Go To Dialog Box
» Hold the CTRL key and tap the G key.
Merge Cells Across
e Tap the ALT key and then tap the H, M, and A keys.

[ Keyglakeaways | l

« READ ME worksheets can serve as a data internal control by providing pertinent information
about a workbook.

e The Go To command is a convenient way to jump to any cell location in a big dataset.

¢ When adding cell capacity to functions, an alert should be added that warns the user when
data is added to a workbook that exceeds the cell range used in functions.

¢ Worksheet protection should be used when there are no user inputs required for a report
that summarizes a big dataset.

8.6 Chapter Assignments and Test

Identifying Inventory Discrepancies (Comprehensive Review)
Starter File Name: Chapter 8 DA Exercise 1

Digital Downloads

Chapter 8 DA Exercise 1.xisx



chaptef 8

Working with Big Datasets Case: Investigating Fraug

hitps://catalog. flatworidknowledge.com/a/34751/Chapter 8_pA_Exercise 1-bdbd.xl
= 2 XISX

Difficulty: Level 2

Many retafltllers havehreturn policies that may allow customers to return merchandi I
gqec;r:hpsufc ﬁarsae gl;rtcoﬁzeéfl-’:g;vi\g;,pi :;Jlrsnrsqgn requgement is that the item retzrr?gd '?:usste t\gz:/?a
res and must i .
pany. 1 sotr)neﬂc’:asis retumn errors can occur such that a ca:tsiearnagggag ?ni?tesr?ﬁo?yr;:jr: (t)rrlgt
is not sold by the store. If the store does not require a receipt, these returns can be done inten-
tionaly 28 £ LY to pilfer money from the company. These 'types of returns may also ble the
resuit of collusion between a customer and a store employee to pilfer mone fromythe store. To
identify if this is happening, inventory discrepancies can be investigated usin)é data analytics'.

The purpose of ﬂjls exercise Is to use the new skills demonstrated in this chapter to identify
inventory return d|screpan0|§as for a hypothetical retailer. Begin the exercise by opening the file
named Chapter 8 DA Exercise 1. Questions that are preceded with the letters KO indicate you
must only use your keyboard and not your mouse to execute the required skill.

1.
2. KO Apply the bold font and Wrap Text alignment to the range A1:H1.

3.

4. KO Insert a new worksheet into the workbook and change the worksheet tab name to Data

10.
11.
12.

13.
14,
15,

16.
17.

18.
19,

20,

KO Change the font style to Arial for the entire dataset in the Inv Transactions worksheet.
KO Apply the Accounting format to all the data in the Amount column.

Copy.

KO Copy the entire dataset in the Inv Transactions worksheet and paste it into the Data
Copy worksheet.

KO Change the width to 15 points for columns C, D, E, F, G, and H on the Data Copy work-
sheet.

KO Open the Inv Transactions worksheet.

_Incell 11 on the Inv Transactions worksheet, type the column heading “Region”.

Enter a RIGHT function in cell 12 that will show the last two characters of the entry in cell A2.
Define the “text” argument with cell A2 and define the “[num_chars]” argument with the num-
ber 2. The last two characters for the data shown in the District column is the abbreviation
of the region. For example, district 10NE is district 10 in the Northeast region. The output of
this function will allow the dataset to be summarized by region.

Copy cell 12 and paste it into all of the rows in the dataset by do
“Week".

hat will show the week number related to the date
; . ueari 4 [ 2. Define the “[return_type]” argu-
in cell C2. Define the serial_number argument with cgll C '

ment with the number 2, which assumes that Monday is the first day of the week. The output

of this function will be useful if additional data is added to the dataset.
Copy cell J2 and paste it into all of the rows in the dataset by double clicking the Fill Handle.

In cell K1, type the column heading “Return Amount”. .
Enter an IF function in cell K2 that will show the absolute value of the returns in the Amount

. tion should evaluate if cell F2 is ]ess than O. If the logical
column. The logical test of the ﬂf(?je]" S rqument with the ABS function. Define the “number”

ﬁ;ﬁ;ﬁeaf‘jtﬁinfégefﬂcat'ﬁ"vaﬂh cell F2. If the logical test is false, the output of the IF func-
tion should be O. ws in the dataset by double clicking the Fill Handle.

it into all of the ro '
Copy cell K2 and paste it into + by olicking the New Comment button in the Review tab of
ntoy the following: “Return amounts are shown

uble clicking the Fill Handle.

In cell J1, type the column heading
Enter the WEEKNUM function in cell J2 t

Click cell K1 and add a comm® 5
the Ribbon. When the comment boX °p‘i,’3§'c‘§,% > ent box
as positive values”. Click cell 11 to close t
ding “Sale Amount-.
tive values (sale transactions) in the

iust the posi , .
that shows hould evaluate if cell F2 is greater than zero.

tion S f
f the func el argument with cell F2. If the logical.test is

In cell L1, type the column hea

Enter an IF function in cell L2
Amount column. The logical test 0
If the logical test is true, defme.the b e i
false, the output of the |F function S - the dataset b S i A

WS
Copy cell L2 and paste it into all of the ro
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i in ascending order based on the following column se .

° gtoor:et.h Zn?gaet:.alt-ﬁgg:ight the entirge dataset and then clicg t?je Sort button jn ltf: c[))ea.tDIStrict'
the Ribbon. This is a critical step that will be required to eliminate the repeating va,
Store Report column.

22. In cell M1, type the column heading “Store Week".

23. Enter a CONCATENATE function into cell M2 that combines the Store ang Week -
Define the “text1"” argument with cell B2, and the “[text2]" argument with cell J2. Mng.

24. Copy cell M2 and paste it into all of the rows in the dataset by double clicking the H
25. In cell N1, type the column heading “Weekly Store Sales”.

26. Enter an IF function in cell N2 that displays the first instance of the values in the Store Re
column. The logical test of the IF function should evaluate if cell M2 is equal to M1, ¢ the ?on
ical test is true, the output of the function should be O. If the logical test is falge <)
of the function should be the value in cell H2.

27. Copy cell N2 and paste it into all of the rows in the dataset by double clicking the Fij Handle
28. Incell O1, type the column heading “SKU Check”.

29. Enter a VLOOKUP function into cell O2 that looks for the SKU (Stock Keeping Unit) Number
in cell G2 in the SKU List worksheet. Define the “lookup_value” argument with cg| &2
Define the “table_array" argument with the range A2:A101 in the SKU List worksheet. Place
an absolute reference on this cell range before defining the next argument, Define the
“col_index_num" argument with the number 1 and the “[range_lookup]” argument with the
word “FALSE" to look for an exact match to the lookup value.

30. Copy cell 02 and paste it into all of the rows in the dataset by double clicking the Fill Handle,
31. In cell P1, type the column heading “"SKU Alert".

32. Enter an IF function in cell P2 that shows an output of 1 if the VLOOKUP function produced
an error output in the SKU Check column. The logical test of the IF function should be
defined with the ISERROR function. Define the “value” argument of the ISERROR function
with cell O2. If the logical test is true, the output of the IF function should be the number 1. If
the logical test is false, the output of the function should be 0.

33. Copy cell P2 and paste it into all of the rows in the dataset by double clicking the Fill Handle,

34. Create a PivotTable using the entire dataset in the Inv Transactions worksheet. Click cell A1
and click the PivotTable button in the Insert tab of the Ribbon. The Create PivotTable dia-
log box should automatically include the entire range of the dataset. The PivotTable should
appear in a separate worksheet and the worksheet tab label should be changed to “Returns
Ratio”.

35. Add the Region and Store fields to the ROWS area of the PivotTable.

36. Change the layout of the PivotTable to the Qutline Form by clicking the Report Layout button
in the Design tab of the Ribbon.

37. Add the Transaction Number field to the VALUES area of the PivotTable.

38. Double click the Sum of Transaction Number column heading on the PivotTable to open the
Value Field Settings dialog box. Change the output calculation to Count and the field namé
to “Transaction Count".

39. Add the Sale Amount field to the VALUES area of the PivotTable. Change the field name t0
“Cash Sales” and format the values to U.S. currency with zero decimal places.

40. Add the Return Amount field to the VALUES area of the PivotTable. Change the field namé
to “Cash Returns” and format the values to U.S. currency with zero decimal places.

41. Add a calculated field by clicking the Fields, Items, & Sets button in the PivotTable Analyze

tab of the Ribbon. The field name should be Returns Ratio. The formula should be the Return
Amount field divided by the Sale Amount field,

42. Format the values in the Sum of Returns Ratio field to a percentage with two decimal

43. Sort the stores on the PivotTable based on the values in the Sum of Returns Ratio field I
descending order. The results of this PivotTable show stores that have a high perceﬂtage 0
returns with respect to sale transactions. These stores may require additional monitoring e

ensure these are all legitimate returns.

44. Create a second PivotTable using the entire data
workshest tab name should be “SKU ALERT".

VO
€S in the

andlg,

p]aC@S.

, Tne
set in the Inv Transactions worksheet
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45.
46.
a7.

48.
49.
50.

51.

52.

53.

Working with Big Datasets Case: Investigating Fraud

Add the SKU Alert Field to the ROWS area of the PivotTable,
change the layout of the PivotTable to the Tabular Form.

Click the down arrow next to the SKU Alert field name on the PivotTable and set a filter so
only the value of 1 is displayed.

Add the District, Store, and SKU fields to the ROWS area of the PivotTable.
Add the Date and Time fields to the ROWS area of the PivotTable.

Remove all subtotals from the PivotTable, and increase the column width of the Date and
SKU fields if needed.

Click the Time column hgading on the PivotTable. Show all values in this field by clicking the
Ungroup button in the PivotTable Analyze tab of the Ribbon.

Add the Amount field to the VALUES area of the PivotTable. The PivotTable shows that store
310 in district 30SE processed returns for SKU 82023138, which is an item that is not sold
by the company. The pattern of these returns is interesting as they all occurred at or after
7:00 p.m., which may be right before the store closes or times when there are fewer people
in the store. Also, notice that the same item was returned for different purchase amounts. In
total, $282.96 was taken from the cash register for these returns.

Save and close your workbook.

Starter File Name: Chapter 8 Skills Test

Digital Downloads

Chapter 8 Skills Test.xIsx
https.//catalog.flatworldknowledge.com/a/34751/Chapter_8_Skills_Test-541a.xlsx

Difficulty: Level 3

Answer the following questions by executing the required skills on the starter file listed above.
Answer each question in the order it appears. Questions that are preceded with the letters KO
indicate you must only use your keyboard and not your mouse to execute the required skill,

1.
2
3
4
5.
6
7
8
9

10.
1.
12,
18,

14,

15,

KO Open the READ ME worksheet.

. KO Change the width of columns A and B to 20 points.
. KO Format the data in cells A1:A4 to Bold and ltalics.
. KO Change the font style for the entire worksheet to Arial and the font size to 12 points.

KO Edit each entry in cells A1:A4 by adding a colon at the very end of the text.

. KO Apply the Merge Across format on the range B4:F4.

- KO Set the alignment in the merged cell beginning with B4 to Align Left.
- KO Format the merged cell beginning with B4 to wrap text.

- KO Add the current date in cell B1.

KO Add the current time in cell B2.
KO Type your last name in cell B3.

KO Increase the height of row 4 to 35 points.

KO Type the following into the merged cell beginning with B4: “Do not change sort sequence
in Store Data workshest.”. Start a new line in this cell, and add the following so that it
appears below the text you just typed: “Read any alerts before using this workbook!”.
Create a PivotTable that shows each unique store from the Store Data worksheet. Your Pjy-
otTable should appear in a separate worksheet, and the worksheet tab should be named
Stores.

Create a second PivotTable that shows the date range from the Store Data worksheet. Your
PivotTable should appear in a separate worksheet, and the worksheet tab should be named
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